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About this document

Scope and purpose

This document serves as a guide for using the CY8CKIT-005 MiniProg4 Program and Debug Kit. The document
explains about the kit operation and technical description of the board.

Intended audience

For people who are interested to explore the functionality of MiniProg4.
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Important notice

Important notice
“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board (PCB)
for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”). 

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards has
been tested by Infineon Technologies only as described in this document. The design is not qualified in
terms of safety requirements, manufacturing and operation over the entire operating temperature range
or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board. 

It is the responsibility of the customer’s technical departments to evaluate the suitability of the Evaluation
Boards and Reference Boards for the intended application, and to evaluate the completeness and
correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property. 

The Evaluation Boards and Reference Boards and any information in this document is provided "as is" and
Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability. 

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided herein
at any time without further notice.
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Safety precautions

Safety precautions

Note: Please note the following warnings regarding the hazards associated with development system.

Table 1 Safety precautions

Caution: The evaluation or reference board contains parts and assemblies sensitive to 
electrostatic discharge (ESD). Electrostatic control precautions are required when 
installing, testing, servicing or repairing the assembly. Component damage may result if 
ESD control procedures are not followed. If you are not familiar with electrostatic control 
procedures, refer to the applicable ESD protection handbooks and guidelines.
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Introduction

1 Introduction
The MiniProg4 Program and Debug Kit is an all-in-one programmer and debugger for PSoC™ 4, PSoC™ 5LP, and
PSoC™ 6 MCU devices. MiniProg4 also provides USB-I2C, USB-SPI and USB-UART bridging functionality. The
MiniProg4 provides a special feature enabling users to write their own custom firmware through the custom
application mode. 
Note: The JTAG protocol for programming and debugging is supported only in CY8CKIT-005-A revision of
Miniprog4.

Figure 1 MiniProg4

1.1 Kit contents
The CY8CKIT-005 PSoC™ MiniProg4 Program and Debug Kit includes:
• MiniProg4 programmer/debugger
• 10-pin ribbon cable
• USB Type-A to Type-C cable
• Quick Start Guide

1.2 Programming and Debugging
The MiniProg4 programmer/debugger provides the flexibility to work with the SWD or JTAG programming and
debugging interface. MiniProg4 supports 32-bit Arm® Cortex®-M0/M0+/M3/M4 PSoC™ devices. 
The MiniProg4 debugger is supported by the software tools PSoC™ Creator, ModusToolbox™ software,
ModusToolbox™ Programming tools, and PSoC™ Programmer.

1.3 Bridging
MiniProg4 supports USB-I2C, USB-UART and USB-SPI as standard bridging protocols for any device. The
MiniProg4 bridging capabilities are used by PSoC™ Creator, ModusToolbox™ software, ModusToolbox™
Programming tools, PSoC™ Programmer, Bridge Control Panel, and other applications. Tuning software tools
such as the CAPSENSE™ tuner provided by Infineon also use these capabilities. 

https://www.infineon.com/cms/en/design-support/tools/programming-testing/psoc-programming-solutions/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-product_families&redirId=Product403
https://www.infineon.com/cms/en/design-support/tools/sdk/psoc-software/psoc-creator/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-product_families&redirId=VL1322
https://softwaretools.infineon.com/tools/com.ifx.tb.tool.modustoolboxprogtools?_ga=2.166861686.913048490.1697547368-680976317.1693311935
https://www.infineon.com/cms/en/design-support/tools/sdk/modustoolbox-software/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-product_families&redirId=VL1299
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Introduction

1.4 Documentation conventions

Table 1 Document conventions for user guides

Convention Usage

Courier New Displays file locations, user-entered text, and source code:
C:\...cd\icc\

Italics Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC™ Designer User Guide.

[Bracketed, Bold] Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open Represents menu paths:
File > Open > New Project

Bold Displays commands, menu paths, and icon names in procedures:
Click the File menu, and then click Open.

Times New Roman Displays an equation:
2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.
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Installing MiniProg4

2 Installing MiniProg4
This chapter shows how to install MiniProg4 and its associated PC software.

2.1 MiniProg4

Figure 2 Top view

Figure 3 Bottom view

2.2 MiniProg4 installation
The MiniProg4 programmer/debugger is supported by PSoC™ Programmer, ModusToolbox™ software,
ModusToolbox™ Programming tools, and PSoC™ Creator. Other software, such as Bridge Control Panel, use the
PSoC™ Programmer COM layer to support MiniProg4 functionality.
Note: PSoC™ Programmer is compatible only with the Windows Operating System however, ModusToolbox™
Programming tools is compatible with Windows, macOS, and Linux. To understand the differences between 
PSoC™ Programmer and ModusToolbox™ Programming tools, please see the CYPRESS™ Programming Solutions
page at https://www.infineon.com/.
1. Download and install PSoC™ Programmer or ModusToolbox™ Programming tools. Follow the on-screen 

instructions to install the software.
Each programming tool supports a subset of Infineon devices. See respective tool documentation for which 
device each supports.

2. Launch the PSoC™ Programmer or ModusToolbox™ Programming tools and connect the MiniProg4 to 
computer’s USB port using the provided USB cable. When properly connected, and drivers have been 
installed, the Mode LED either turns ON or will be ramping (slowly increasing and decreasing brightness) 
depending on the mode. 
Note that the MiniProg4 drivers are automatically installed.

https://www.infineon.com/cms/en/design-support/tools/programming-testing/psoc-programming-solutions/?utm_source=cypress&utm_medium=referral&utm_campaign=202111_globe_en_all_integration-vanity&redirId=VL4294
https://www.infineon.com/cms/en/design-support/tools/programming-testing/psoc-programming-solutions/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-product_families&redirId=Product403
https://softwaretools.infineon.com/tools/com.ifx.tb.tool.modustoolboxprogtools?_ga=2.166861686.913048490.1697547368-680976317.1693311935
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Installing MiniProg4

3. In PSoC™ Programmer, to connect to the port, in the Port Selection pane, click the MiniProg4 device. Click on 
Connect/Disconnect button as shown in Figure 4.
If the connection is successful, a status indicator in the lower-right corner of the PSoC™ Programmer window 
turns green and shows “Connected”.
You can now use MiniProg4 to program the target device by clicking the Program button.

Figure 4 PSoC™ Programmer: MiniProg4 Connect/Disconnect and Program 

For more information on PSoC™ Programmer, see Help Topics under the Help menu in PSoC™ Programmer or
press [F1].
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Installing MiniProg4

In ModusToolbox™ Programming tools, to connect to the MiniProg4 probe, click Connect/Disconnect button as
shown in Figure 5.
If the connection is successful, a status indicator in the lower-right corner of the ModusToolbox™ Programming
tools window turns green and shows “Connected”.
MiniProg4 can be used to program the target device by clicking the Program button.

Figure 5 MiniProg4 Connect/Disconnect and program 

For more information on ModusToolbox™ Programming tools, see View Help under the Help menu in
ModusToolbox™ Programming tools or press [F1]. 
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Installing MiniProg4

2.3 MiniProg4 LEDs
MiniProg4 has three indicator LEDs - Mode (Amber), Status (Green), and Error (Red) as shown in Figure 6. Table 2
indicates the behavior of these LEDs for various operations. 

Figure 6 MiniProg4 LEDs 

Table 2 LED representation for various operations of MiniProg4

Programming mode
Programming 
status

Three LEDs

Mode indicator 
(Amber LED)

Status indicator 1 
(Green LED)

Status indicator 2 
(Red LED)

CMSIS-DAP HID

Programming

Ramping (1 Hz)

8 Hz OFF

Success ON OFF

Error OFF ON

Idle OFF OFF

CMSIS-DAP Bulk

Programming

ON

8 Hz OFF

Success ON OFF

Error OFF ON

Idle OFF OFF

Bootloader N/A 1 Hz OFF OFF

Custom application N/A 8 Hz ON ON
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Installing MiniProg4

2.4 MiniProg4 buttons
MiniProg4 has two buttons that enable switching between various operating modes. Figure 7 shows the location
of the buttons. In order to understand switching MiniProg4 modes, see Figure 8.
On power-up, MiniProg4 is in CMSIS-DAP/BULK mode by default. If the Mode Select button is pressed, MiniProg4
enters CMSIS-DAP/HID mode. If the Custom App button is pressed, MiniProg4 enters the custom application
mode, where a user can run their own custom applications on the MCU contained in the MiniProg4, see Figure 8. 
For details on LED indications of various modes of MiniProg4, see Table 2.

Figure 7 MiniProg4 buttons 

Figure 8 Various MiniProg4 button modes 
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3 Technical description
MiniProg4 is a protocol translation device. With MiniProg4, the PC host software can communicate through a USB
port to the target device to be programmed or debugged, as shown in Figure 9. Table 3 lists the protocols that
are supported by each connector. MiniProg4 enables communication with the target devices using I/O voltage
levels from 1.5 V to 5 V. 

Figure 9 System block diagram 

Table 3 Connectors / Communication Protocol support

Connector SWD JTAGa)

a) JTAG is supported only in CY8CKIT-005-A.

I2C SPI
UART 
(with and without flow control)

5-pin Supported N/A N/A N/A N/A

10-pin Supported Supported N/A N/A N/A

6x2 header N/A N/A Supported Supported Supported

PC

MiniProg4

Target Board

USB Cable

10-pin Ribbon 
Cable or 5-pin 

Direct 
Connection

12-pin 
Communication 

Header

SWD/
JTAG

I2C/
UART/

SPI
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3.1 Interfaces

3.1.1 SWD/JTAG
Arm®-based devices support the Serial Wire Debug (SWD) and JTAG protocols. The PSoC™ 4, PSoC™ 5LP, and
PSoC™ 6 MCU device families implement these standards, which offers programming and debugging functions.
MiniProg4 supports programming and debugging of PSoC™ 4, PSoC™ 5LP, and PSoC™ 6 devices using SWD and
JTAG through the 5-pin or 10-pin connector.
Before programming a PSoC™ 4, PSoC™ 5LP, or PSoC™ 6 MCU device, the electrical connection requirements in
the respective device datasheet are reviewed or in the PSoC™ 4, PSoC™ 5LP, and PSoC™ 6 MCU device
programming specifications. The list of datasheets and programming specifications are as follows: 
www.infineon.com/PSoC4
www.infineon.com/PSoC5LP
www.infineon.com/PSoC6

3.1.2 I2C
I2C is a common serial interface standard. It is mainly used for communication between microcontrollers and
other ICs on the same board but can also be used for intersystem communications. MiniProg4 uses an I2C
multimaster host controller that allows the tool to exchange data with I2C-enabled devices on the target board.
For example, this feature may be used to tune CAPSENSE™ designs.
MiniProg4 serves as a USB-I2C bridge (acts as I2C master) that can be used to communicate with a I2C slave devices
through the Bridge Control Panel software. For I2C connections use the 6×2 connector. MiniProg4 has internal
pull-up resistors and supports I2C speed up to 1 MHz.

3.1.3 SPI
The serial peripheral interface (SPI) is a synchronous serial communication interface specification used for short
distance communication, primarily in embedded systems. SPI devices communicate in full duplex mode using a
master-slave architecture with a single master. 
MiniProg4 serves as a USB-SPI bridge (acts as SPI master) that can be used to communicate with a SPI slave
devices through the Bridge Control Panel software. For SPI connections, use the 6×2 connector. MiniProg4
supports SPI speed up to 6 MHz.

3.1.4 UART with and without flow control
UART is another common serial interface standard. MiniProg4 supports UART, which allows the tool to receive
data from UART enabled devices on the target board. MiniProg4 provides UART communication both with and
without hardware flow control. In order to enable flow control, RTS and CTS pins are provided in the 6x2 I/O
header. If flow control is not required, CTS and RTS pins can be left floating. Terminal emulators such as Tera
Term or PuTTY can be used to communicate with the target PSoC™ device. MiniProg4 supports UART speed up to
115200 Baud Rate.

3.1.5 Reference
For more information on the PSoC™ 4, PSoC™ 5LP, and PSoC™ 6 MCU’s JTAG, SWD, and I2C interfaces, see the
PSoC™ 4, PSoC™ 5LP, and PSoC™ 6 Technical Reference Manuals. 
For more details on MiniProg4 with Bridge Control Panel, refer to the Bridge Control Panel Help document.

https://www.infineon.com/cms/en/search.html#!view=all&term=PSoC%20TRM&area=downloads
https://www.infineon.com/cms/en/product/microcontroller/32-bit-psoc-arm-cortex-microcontroller/psoc-4-32-bit-arm-cortex-m0-mcu/
https://www.infineon.com/cms/en/product/microcontroller/32-bit-psoc-arm-cortex-microcontroller/32-bit-psoc-5-lp-arm-cortex-m3/
https://www.infineon.com/cms/en/product/microcontroller/32-bit-psoc-arm-cortex-microcontroller/psoc-6-32-bit-arm-cortex-m4-mcu/
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3.2 Connectors

3.2.1 5-pin connector
The 5-pin connector is configured as a single row with a 100-mil pitch. Suggested mating connector part number
is Molex Connector Corporation 22-23-2051.

Figure 10 5-pin connector with pin assignments 

Note: If the design requires MiniProg4 to be directly plugged to the target board with a 5-pin header, adequate
mechanical clearance shall be provided near the 5-pin header on the target board. The width and height of
MiniProg4 (5-pin header area) is 25 mm × 13 mm. If the design cannot meet the required mechanical clearance,
use a stackable header (such as Proto-PIC 20690). 

3.2.2 10-pin connector
The 10-pin connector is configured as a dual row with 50-mil pitch. It is used with a ribbon cable (provided) to
mate to a similar connector on the target board. The signal assignment is shown in Figure 11. Suggested mating
connector part number is CNC Tech 3220-10-0300-00 or Samtec Inc. FTSH-105-01-F-DV-K-TR.

Figure 11 10-pin connector with pin assignments 

MiniProg4 
(End View)

Mating 
Connector

SDAT

SCLK

XRES

GND

VTARG

XRES

TDI

VTARG

GND

GND

GND

GND

TDI

TDO / SWO

TMS / SWDIO

VTARG

GND

Pin 1

Note The ribbon 
cable connector 

extends beyond the 
body of the 

connector.  Be sure 
to allow room.

GND

GND

GND

TCK / SWCLK
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Table 4 shows the summary of the protocols and related pin assignments. The pin mapping is also shown on the
back of the MiniProg4 case.

3.2.3 6×2 connector
This connector supports all the communication protocols like I2C, SPI, UART (with or without flow control
supported by MiniProg4). Figure 12 shows the pin assignments. They are also shown on the back of the
MiniProg4 case.

Figure 12 6×2 connector pin assignments 

Table 4 Communication protocol pin assignments

Protocol Signal 5-pin 10-pin

SWD

SDIO 5 2

SCK 4 4

XRES 3 10

JTAGa)

a) JTAG is supported only in CY8CKIT-005-A.

TMS N/A 2

TCK N/A 4

TDO N/A 6

TDI N/A 8

XRES N/A 10



User guide 16 002-19782 Rev. *D 
   2023-10-18

CY8CKIT-005 MiniProg4 Program and Debug Kit guide
 

 

Technical description

3.3 Power
MiniProg4 can be powered using the USB interface. 
On kits/boards where there is a single power supply for the entire board, MiniProg4 can supply power to the
board. However, this supply is limited to approximately 200 mA, and is protected against excess current draw.
You can select 1.8 V, 2.5 V, 3.3 V, or 5 V from PSoC™ Programmer. The 5 V supply may vary between 4.25 V–5.5 V,
because it is supplied directly from the USB port. The maximum deviation for other voltages is +5%.
Note: Some PSoC™ device families do not support 5 V operation. Refer to the respective device datasheet for
supported voltage selection. 

Voltage stress beyond acceptable limits can permanently damage MiniProg4.
Programming signals can withstand over-voltage up to maximum 12 V and minimum
up to –5 V. Communication bridge signals (I2C, UART & SPI) can withstand over-voltage
only up to maximum 6 V and minimum up to –1 V.
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Appendix

Appendix

A Regulatory Compliance information
The CY8KCIT-005 MiniProg4 Program and Debug Kit complies with the CE-Low Voltage Directive 2006/95/EC
(Europe) safety requirement. It has been tested and verified to comply with the following electromagnetic
compatibility (EMC) regulations.
• CISPR 22 - Emissions
• EN 55022 Class A - Immunity (Europe)
• CE - EMC Directive 2004/108/EC
• CE Declaration of Conformity
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